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1 - About GPinfo
GPinfo 6.0 is a fully featured Geographical Information System for desktop
data visualization and manipulation of oil and gas industry data. Data is
provided on a subscription basis. Regular data and software updates are
made available via the Internet. It is an essential tool for commercial analysis,
portfolio analysis, exploration, new ventures, business planning, and
development.
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GPinfo data sets
The GPinfo data set covers Australia, Papua New Guinea and New Zealand. The core of the GPinfo
data is the Permit, Well and Company databases.
•

The Permit database contains information on all current petroleum, geothermal and sequestration
permits in the region, including ownership details.

•

The Well database contains information on all wells ever drilled in the region, approximately
27,000 to date.

•

The Company database contains details on more than 3,000 active exploration, service and other
industry-related companies. The Company database lists a wide range of company data including
addresses, key personnel, assets, and shareholdings.

•

The GPinfo History Module (GHM) is an optional add-on to the standard GPinfo subscription
which provides access to detailed permit history since 1991.

A range of other graphical data layers is also supplied, including map sheets, fields, pipelines, towns,
state and offshore boundaries, bathymetry, and coastlines. In addition, various third-party seismic
databases are available, including Geoscience Australia's Marine Seismic.
Currently GPinfo data updates are released monthly.

About this guide
This guide provides detailed instructions for installing GPinfo program files, data sets, and monthly
data updates on a standalone PC or a network server.
This manual is available as a Portable Document File (PDF), which is installed with the software. Refer
to the Getting help section of this guide for more information about accessing the documentation and
instructions for viewing PDF files.

Conventions used in this guide
Certain conventions are used throughout this manual:
•

Keys on the keyboard appear in small capital letters. For example, the Ctrl key appears as CTRL
in the text.

•

Menu options, buttons, and dialog labels are in boldface. For example, “On the File menu, click
Exit.”

•

The shorthand form menu>submenu>item indicates the menu path to an option. For example,
“Select View>Toolbars>Query.” is equivalent to the instruction “On the View menu, point to
Toolbars, and then click Query.”

•

References to other sections in the documentation are italicised. For example, see Displaying
license information. If the text is blue (online documents only), clicking the text will take you to that
reference. References to other publications that are not linked are shown in black italised text.

•

File and folder names and paths are shown enlarged and monospaced. For example,
disk:\Documents and Settings\username\Desktop
where the italicised terms “disk” and “username” are placeholders.
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•

Programming terms, variables, screen text, and text that you type are shown monospaced. For
example, “Click the Value box and type null.”

•

Options that you select from a list are shown enclosed by < > symbols. For example, “Click the
Projection box and select <Custom>.”
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2 - Getting help
Should difficulties or questions arise while installing or operating GPinfo,
there are several sources of help available.
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GPinfo manuals and help
The following electronic manuals and help are installed with the software:
•

GPinfo Installation Guide provides detailed instructions on installing the software and data
updates. It is supplied as a PDF file.

•

GPinfo Help is a comprehensive and accessible reference on using the software. Help can be
displayed from the GPinfo Help menu or by pressing the F1 key. Instructions on using Help can
be found in the Microsoft Windows Users Manual.

Note:

If you experience problems opening Help, it is usually due to the security settings on your
computer. Contact your system adminstrator for assistance.

•

GPinfo User Guide is a print-friendly version of the topics found in GPinfo Help.

•

The GPinfo troubleshooting guide can be found in the GPinfo Help and GPinfo User Guide.

Related topics
Contacting GPinfo support
Viewing and printing the electronic manuals

Contacting GPinfo support
You can contact GPinfo Support by e-mail, fax, and telephone.
E-mail

gpinfo@pb.com

Web

www.pitneybowes.com/pbencom/products/data/
gpinfo.html

Fax

+61 2 9475 3599

Telephone

+61 2 9475 3500

To contact GPinfo Support by e-mail:
1. On the Help menu, click Contact GPinfo Support
2. An e-mail is created in your default mail program, into which you can type your contact details and
describe the nature of your query.

Viewing and printing the electronic manuals
The manuals are in the form of PDF files that can be viewed on-screen, or once displayed, can be
printed in part or in full. To view or print the files, Adobe Reader must be installed on your computer.
Adobe Reader is available (at no cost) from the Adobe web site www.adobe.com.
To view the electronic manuals with Adobe Reader:
1. In Windows Explorer, navigate to the Common application data folder (standalone only) selected
during installation.
2. Double-click the PDF file name, for example GPinfo User Guide.pdf. Alternatively, right-click
the file name and choose Open.
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3 - System
requirements
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GPinfo system requirements
The computer hardware and software requirements to install and operate GPinfo (standalone or
server) are:

Windows® operating system
Version 6.0 of the GPinfo will run under the following operating systems:
32-bit operating systems
•

Windows 7

•

Windows 8

•

Windows 10

64-bit operating systems
•

Windows Server 2008 R2 or later

•

Windows 7

•

Windows 8

•

WIndows 10

During installation, the GPinfo installation will update selected system files, if required. This should not
cause problems with any other software that accesses the library. If, for some reason, you believe that
another application no longer operates properly after GPinfo has been installed, please contact GPinfo
Support (see Contacting GPinfo support).

CPU
GPinfo should be installed on a Pentium 1 GHz (2 GHz recommended) PC, with a minimum of 1 GB
(2 GB recommended) of memory.

Graphics monitor
A high-quality graphics monitor of at least SVGA capability (1024 x 768 pixel screen display) is
recommended for GPinfo. Higher screen resolutions and a 64MB graphics card or higher memory
graphics card also will improve the appearance and ease of use of GPinfo.

Hard disk
GPinfo requires approximately 1 GB of available disk space to store the executable, library files, and
data files supplied with the software.

Internet browser
GPinfo requires Internet Explorer version 7.0 or later.
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Adobe Reader
Adobe Reader version 6 or later is required to view PDF files supplied with the software.

License server requirements
The Floating License Server is supported on the following operating systems:
•

Windows 7 SP1 (32-bit and 64-bit)

•

Windows Server 2008 R2 (32-bit and 64-bit)

•

Windows 8 (32-bit and 64-bit)

•

Windows 8.1 (32-bit and 64-bit)

•

Windows Server 2012 (64-bit)

The hardware requirements are minimal on the license server. An open TCP/IP port (6150 is opened
by default in the Windows firewall during installation) is required for the server to communicate on.
See also
Getting help
Installing the software
Licensing the software
Installing GPinfo data updates
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4 - Installing the
software
This section describes the processes for installing and licensing the software
and data on either a standalone PC or a network server.
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Installing on a standalone PC
•

Downloading GPinfo

•

Installing GPinfo

Downloading GPinfo
To download the GPinfo standalone installation program:
1. Start Internet Explorer and go to:
http://web2.encom.com.au/gpinfo/GP6_StandaloneSetup.exe
2. From the File Download dialog box, click Save to download the file to your local disk, or click Run
to download and start the installation. If you select Save, double-click the downloaded file to start
the installation.
Note:

Close all programs before you start the installation. During installation you may be asked to reboot
your system or a reboot may occur automatically.

3. When the installation starts, type the password provided by GPinfo Support, and then follow the
instructions for Installing GPinfo.

Installing GPinfo
Note:

If you are upgrading an existing installation, you must uninstall the older version of GPinfo first (see
Uninstalling GPinfo).

Note:

In some installations, access to application folders is restricted to system administrators. Under
Windows 7 and 8, installation programs can only be run from an account with administrator
privileges. If your user account does not have sufficient permissions to install new software, please
contact your system administrator before installing GPinfo 6.0.

The installation program guides you through the installation procedure. As the installation proceeds,
you are asked to confirm or select various installation options:
•

Destination Folder – Installing GPinfo in the default location (C:\Program
Files\Encom\GPinfo) is strongly recommended. To change the installation folder location, click
Change and select a different location. For more information about installation folders, see
Installation folders.

•

Licence Manager Type – Under License Type, select Local User - Single user licence.
Initially, GPinfo is not licensed and, when you first run the program, it requests you license the
software. To license GPinfo, see Licensing GPinfo on a standalone PC.

Finally, click Install to complete the installation.
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Installing on a server
•

Prerequisites

•

Downloading GPinfo

•

Installing GPinfo on a server

Prerequisites
•

The server PC must be accessible to all GPinfo users

•

All GPinfo users must have Full Control rights to the GPinfo installation folder on the server.

Downloading GPinfo
To download the GPinfo server installation program:
1. Log on to the server.
Note:

You can also install GPinfo remotely to a mapped drive or network location.

2. Start Internet Explorer and go to:
http://web2.encom.com.au/gpinfo/GP6_ServerSetup.exe
3. From the File Download dialog box, click Save to download the file to a local disk, or click Run to
download and start the installation. If you select Save, double-click the downloaded file to start
the installation.
Note:

Close all programs before you start the installation. During installation you may be asked to reboot
your system or a reboot may occur automatically.

4. When the installation starts, type the password provided by GPinfo Support, and then follow the
instructions for Installing GPinfo.

Installing GPinfo on a server
Note:

If you are upgrading an existing installation, you must uninstall the older version of GPinfo first.

Note:

In some installations, access to application folders is restricted to system administrators. Under
Windows 7 and 8, installation programs can only be run from an account with administrator
privileges. If your user account does not have sufficient permissions to install new software, please
contact your system administrator before installing GPinfo 6.0.

The installation program guides you through the installation procedure. As the installation proceeds,
you are asked to confirm or select various installation options:
•

Destination Folder – If you install GPinfo into a non-standard location, make a note in the
administrator protocols for future reference. If you are installing the software remotely, click
Change to select the installation folder location on the server. This can be either a mapped drive
or a network path. For more information about installation folders, see Installation folders. Click
Next to continue.

•

Licence Manager Type – Under License Type, type the License Server Name and License
Server Port Number where the License Server will be installed. Click Next to continue.
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Example only—type in the details that are relevant to your server

Finally, click Install to complete the installation.
When the software installation is complete, you are asked if you want to license the installation. Click
No. To license and run GPinfo from a client PC, see Network licensing.

Installation folders
•

Program files folder

•

Common application data folder (standalone only)

•

Working files and user configuration file

Program files folder
During installation, the GPinfo program files are copied into the specified destination folder. When you
run the installation program, you will be asked to supply the name of a destination folder. The default
folder is C:\Program Files\Encom\GPinfo. Installing GPinfo in the default installation is strongly
recommended.
Note:

GPinfo is a 32-bit application. If you are installing GPinfo on a 64-bit system, it must be installed
under C:\Program Files (x86).

Common application data folder (standalone only)
During installation, the GPinfo data files are copied into the Common Application Data folder
C:\ProgramData\Encom\GPinfo\.
Note:

On network installations, all data files are installed under the GPinfo installation folder.

Note:

GPinfo 6.0 standalone installations uses a different folder structure to earlier versions. The change
in structure is required for compatibility with Windows 7 and 8.

Note:

The Common Application Data folder is usually flagged as a hidden folder. If this is the case, it will
not be visible to you in Windows Explorer. To reveal hidden folders, in Windows Explorer, on the
Tools menu, click Folder Options. From the Folder Options dialog box, click the View tab, and
then click Show hidden files and folders.

Working files and user configuration file
The default location for your working files and user configuration file (GPinfo.GMP) is
C:\Users\<username>\Documents\My GPinfo Files. Where <username> is your Windows user
name.
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Uninstalling GPinfo
To uninstall GPinfo:
•
Note:

Open the Windows Control Panel and from Add/Remove Programs select GPinfo.
When GPinfo is uninstalled, user data files are not removed.
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5 - Licensing the
software
GPinfo is protected under international copyright law. The GPinfo licensing
system is designed to protect against unlawful copying and use of the
software. GPinfo is supplied with hard-disk and floating network license
systems. This section describes the processes for licensing the GPinfo
software on either a single PC or a network server.

In this section
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Licensing GPinfo on a standalone PC
An Activation Code, which is unique to each computer, is required to run the software. Licensing
GPinfo involves obtaining an Activation Code from GPinfo Support. Hard-disk licenses can be moved
from one machine to another without contacting GPinfo Support.
When licensing GPinfo, choose from the following licensing procedures:

Display information about PBS software installed on your computer
•

Displaying license information

Reinstalling GPinfo
If GPinfo is installed on the computer with a valid license, the software does not need to be relicensed
when you reinstall the software. Your current GPinfo data files and settings will be preserved.
GPinfo has not been previously licensed on the computer
A hard-disk license is required. For detailed instructions, see:
•

Licensing a new installation

The license is being transferred from another computer
You can transfer a license from one computer to another without contacting GPinfo Support. For
detailed instructions, see:
•

Transferring a hard-disk license

A later version of the software has been installed
If you are upgrading an installation with a valid license to a later version of the software, the licensing
procedure is the same as Licensing a new installation.

Licensing a new installation
To license your installation, follow these steps:
1. Start GPinfo.
2. You are asked to select the location for your GPinfo user configuration file (GPinfo.gmp). The
configuration file stores display settings, queries and external links set up by the user during their
GPinfo sessions. We recommend that you accept the default folder. For more information, see
Installation folders.
3. A message is displayed indicating that a valid license was not found. Click Yes.
4. The Create License File dialog box is displayed. Type the company name and click OK. The
License Manager is displayed.
5. Select the Activate License tab.
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6. Under Request Activation, the License Type (Local), Hardware ID, and Product (GPinfo) are
displayed. Type your user name and email address in the appropriate boxes.
Note:

Customer No. and Serial Number are not used by GPinfo licensing.

7. Click the Automatically submit request and activate button.
Alternatively, for off-line activations, click the Save request button and follow the
instructions displayed.
8. GPinfo Support will process your request and supply an activation code by return e-mail
within one working day.
9. On receiving your activation code, in Licence Manager, click the Activate License tab,
copy the activation code from the e-mail into the Activation Code box, and click the
Activate button.
Note:

If an error message is displayed, send the e-mail notification (sent to the e-mail address you
provided above) to GPinfo Support (see Contacting GPinfo Support) for assistance.

10. A report is displayed, which summarises the loaded data layers. This report is displayed the first
time GPinfo is run and after each monthly data update. Click OK.
11. The GPinfo splash screen is displayed, which displays which data set is installed. If the data set is
more than six weeks old, a warning is displayed. Click OK to close the splash screen.
GPinfo is now ready to use. For information about how to use the GPinfo interface, refer to the topics
in GPinfo Help.

Transferring a hard-disk license
If a hard-disk license is operating effectively on one computer (the source), you can transfer the license
to a second computer (the destination). This can be done without contacting PBA. Follow the steps
below to transfer a valid license from one computer to another.
Install the software on the destination computer
1. Install GPinfo on the second, destination computer. The version of the software on the source and
destination computers must be identical.
Start GPinfo on the destination computer
2. On the destination computer, start GPinfo. A message is displayed indicating no license was
found.
3. Click Yes.
4. The Create License File dialog box is displayed. Type the company name and click OK. The
License Manager is displayed.
Obtain the hardware ID of the destination computer
5. Select the Activate License tab.
6. Write down the 7-digit code displayed in the Hardware ID box.
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Transfer the license from the source computer
7. On the source computer, start GPinfo.
8. From the File menu, click Licensing. The License Manager is displayed.
9. At Step 2 of the Transfer License tab, type in the Destination Hardware ID you recorded earlier.
To return or “park” the license with PBS, type 4666666 as the destination ID.
Note:

The license transfer will disable the license on the source machine. The source computer license
cannot be reactivated unless the license is transferred back from the destination computer or a
new activation code is obtained from PBS.

10. At Step 3 of the Transfer License tab, click Create Transfer Activation Code. You will
be prompted to confirm the destination hardware ID.
Note:

The license on the source computer is now disabled.

11. The activation code for the destination computer is displayed. Write down the activation code.
Activate the license on the destination computer
Note:

The activation code is only valid for 2 weeks. The license on the destination computer must be
activated within this time.

12. If necessary, restart GPinfo on the destination computer and display the License Manager as
described in steps 2 through 4.
13. On the Activate License tab, type in the Activation Code that you obtained from the source
computer.
14. Click the Activate button. A message is displayed confirming that the license has been
successfully transferred.
15. Click OK.
GPinfo is now ready to use.
If the transfer was not successful, on the source computer, browse to the C:\ProgramData\Encom
folder and open the file Transfer_Log.txt file. This contains a copy of the activation code generated
for the license transfer.
Note:

If you need to transfer the GPinfo license back to the original machine, you must repeat the transfer
procedure.

Network licensing
•

Managing network server licenses

•

Setting up a client PC

Managing network server licenses
For information on managing GPinfo network server licenses, refer to the pbEncom License Manager
Guide.
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Setting up a client PC
To set up a client PC to run a GPinfo server installation:
1. Browse to the GPinfo installation folder on the server.
2. Right click on GPinfo.exe, point to Send To, and click Desktop (create shortcut). A shortcut to
the GPinfo program will be placed on your desktop.
3. On the Desktop, right-click on the GPinfo icon, and select Properties.
4. On the Shortcut tab, click the Run box, and select Maximized. Click OK.
5. From the client PC, start GPinfo.
6. You are asked to select the folder in which the user's GPinfo configuration file (GPinfo.gmp) is
stored. The configuration file stores display settings, queries and external links set up by the user
during their GPinfo sessions. We recommend that you accept the default folder. To use a different
folder, click the Browse button and select another location. Click OK to continue.
7. You are asked if you want to license the client PC. Click Yes.
8. You are asked if you want to connect to the license server. Click Yes.
9. On the License Server Location dialog box, type the name or IP address of the server where the
Encom License Manager is installed. Click OK.
The Floating License Manager opens.
10. Close the Floating License Manager and GPinfo starts.
GPinfo is now licensed and ready to use on the client PC.

Displaying license information
After you have installed and licensed the software, to display information about the installed license,
from the File menu, click Licensing. The License Manager is displayed.
The Licensed Software tab provides details of what License Types are available on the computer,
and what Product Licenses are activated or available. When you select a product, the product options
and details will be displayed.
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6 - Starting GPinfo
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Starting GPinfo
1. To start GPinfo:
2. Double-click the GPinfo icon on your desktop.
Alternatively, if the GPinfo software was installed locally, from the Programs menu on
the Windows Start menu, point to Encom Programs, and then click GPinfo.
3. If a data update has recently been installed (see Installing GPinfo data updates), a
summary data report is displayed. Click OK to close the report.
4. The GPinfo splash screen is displayed, which displays which data set is installed. If the data set is
more than six weeks old, a warning will be displayed.

5. Click OK to close the splash screen.

GPinfo user interface

For information about how to use the GPinfo interface, refer to the topics in GPinfo Help.
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To set up GPinfo to start in a maximised window:
1. On the Desktop, right-click on the GPinfo icon, and select Properties.
2. On the Shortcut tab, click the Run box, and select Maximized.
3. Click OK.

GPinfo 6.0

Installation Guide

21

7 - Installing GPinfo
data updates
GPinfo data is updated monthly. When a new data set is available, the
installer is placed on the GPinfo web site and users are notified by e-mail.
The first section of the GPinfo update monthly newsletter contains a link to
download the installer and the password to run the installer. The password
changes each month. The instructions in this section apply to both the
general GPinfo data update and the History data update.

In this section
Installing a monthly update on a standalone PC
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Installing a monthly update on a standalone PC
To install the monthly update:
1. From the update newsletter, click the download link.
2. From the File Download dialog box, click Save to download the file to your local disk, or click Run
to download and start the installation. If you selected Save, double-click the downloaded file to
start the installation.
3. The destination folder for the update is displayed. GPinfo retains details of the installation folder
where GPinfo is installed. Click Next.
4. When prompted, type the monthly password from the GPinfo update newsletter.
Note:

The default folder for a data-only update is C:\ProgramData\Encom\GPinfo.

Note:

For 32-bit systems, the GPinfo program is installed under C:\Program Files and for 64-bit
systems, the GPinfo program is installed under C:\Program Files (x86). In both cases, the data
is installed under C:\ProgramData\Encom\GPinfo.

Installing a monthly update on a server
Note:

You must install the update from either the server (where the GPinfo software is installed) or from
a licensed client PC (where GPinfo has been previously run).

To install the monthly update:
1. Log on to either the server where GPinfo is installed or a client PC with an active floating network
license.
2. From the update newsletter, click the download link.
3. From the File Download dialog box, click Save to download the file to your local disk, or click Run
to download and start the installation. If you selected Save, double-click the downloaded file to
start the installation.
4. The destination folder for the update is displayed. Whether installing from the server or a client
PC, GPinfo retains details of the installation folder on the server where GPinfo is installed. Click
Next.
5. When prompted, type the monthly password from the GPinfo update newsletter.
Note:

For 32-bit systems, GPinfo is installed under C:\Program Files and for 64-bit systems, GPinfo is
installed under C:\Program Files (x86).
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